www.philips.com/welcome

EN  User manual  1
    Customer care and warranty  29
    Troubleshooting & FAQs  35
Table of Contents

1. Important ................................................. 1
   1.1 Safety precautions and maintenance...1
   1.2 Notational Descriptions ................. 2
   1.3 Disposal of product and packing material ........................................... 3

2. Setting up the monitor ......................... 4
   2.1 Installation ........................................... 4
   2.2 Operating the monitor ...................... 5
   2.3 Remove the Base Assembly for VESA Mounting ........................................... 8
   2.4 MHL (Mobile High-Definition Link) introduction ........................................... 8

3. Image Optimization .............................. 10
   3.1 SmartImage \textsuperscript{GAME} .............................. 10
   3.2 SmartContrast ......................................... 12
   3.3 Philips SmartControl .......................... 12

4. Technical Specifications ....................... 19
   4.1 Resolution & Preset Modes ............... 21

5. Power Management ............................... 22

6. Regulatory Information ........................ 23

7. Customer care and warranty ................. 29
   7.1 Philips' Flat Panel Monitors Pixel Defect Policy .............................. 29
   7.2 Customer Care & Warranty ............... 31

8. Troubleshooting & FAQs ..................... 35
   8.1 Troubleshooting ..................................... 35
   8.2 SmartControl FAQs ............................. 36
   8.3 General FAQs ...................................... 37
   8.4 MHL FAQs .......................................... 39
   8.5 Gaming FAQs ...................................... 40
1. Important

This electronic user’s guide is intended for anyone who uses the Philips monitor. Take time to read this user manual before you use your monitor. It contains important information and notes regarding operating your monitor.

The Philips guarantee applies provided the product is handled properly for its intended use, in accordance with its operating instructions and upon presentation of the original invoice or cash receipt, indicating the date of purchase, dealer’s name and model and production number of the product.

1.1 Safety precautions and maintenance

Warnings
Use of controls, adjustments or procedures other than those specified in this documentation may result in exposure to shock, electrical hazards and/or mechanical hazards.

Read and follow these instructions when connecting and using your computer monitor.

Operation
• Please Keep the monitor out of direct sunlight, very strong bright lights and away from any other heat source. Lengthy exposure to this type of environment may result in discoloration and damage to the monitor.
• Remove any object that could fall into ventilation holes or prevent proper cooling of the monitor’s electronics.
• Do not block the ventilation holes on the cabinet.
• When positioning the monitor, make sure the power plug and outlet are easily accessible.
• If turning off the monitor by detaching the power cable or DC power cord, wait for 6 seconds before attaching the power cable or DC power cord for normal operation.

• Please use approved power cord provided by Philips all the time. If your power cord is missing, please contact with your local service center. (Please refer to Customer Care Consumer Information Center)
• Do not subject the monitor to severe vibration or high impact conditions during operation.
• Do not knock or drop the monitor during operation or transportation.

Maintenance
• To protect your monitor from possible damage, do not put excessive pressure on the LCD panel. When moving your monitor, grasp the frame to lift; do not lift the monitor by placing your hand or fingers on the LCD panel.
• Unplug the monitor if you are not going to use it for an extensive period of time.
• Unplug the monitor if you need to clean it with a slightly damp cloth. The screen may be wiped with a dry cloth when the power is off. However, never use organic solvent, such as, alcohol, or ammonia-based liquids to clean your monitor.
• To avoid the risk of shock or permanent damage to the set, do not expose the monitor to dust, rain, water, or excessive moisture environment.
• If your monitor gets wet, wipe it with dry cloth as soon as possible.
• If foreign substance or water gets in your monitor, please turn the power off immediately and disconnect the power cord. Then, remove the foreign substance or water, and send it to the maintenance center.
• Do not store or use the monitor in locations exposed to heat, direct sunlight or extreme cold.
• In order to maintain the best performance of your monitor and use it for a longer lifetime, please use the monitor in a location that falls within the following temperature and humidity ranges.
1. Important

- Temperature: 0-40°C 32-95°F
- Humidity: 20-80% RH
- IMPORTANT: Always activate a moving screen saver program when you leave your monitor unattended. Always activate a periodic screen refresh application if your monitor will display unchanging static content. Uninterrupted display of still or static images over an extended period may cause “burn in”, also known as “after-imaging” or “ghost imaging”, on your screen.

"Burn-in", "after-imaging", or "ghost imaging" is a well-known phenomenon in LCD panel technology. In most cases, the “burned in” or “after-imaging” or “ghost imaging” will disappear gradually over a period of time after the power has been switched off.

**Warning**
Failure to activate a screen saver, or a periodic screen refresh application may result in severe “burn-in” or “after-image” or “ghost image” symptoms that will not disappear and cannot be repaired. The damage mentioned above is not covered under your warranty.

Service

- The casing cover should be opened only by qualified service personnel.
- If there is any need for any document for repair or integration, please contact with your local service center. (please refer to the chapter of "Consumer Information Center")
- For transportation information, please refer to "Technical Specifications”.
- Do not leave your monitor in a car/trunk under direct sun light.

**Note**
Consult a service technician if the monitor does not operate normally, or you are not sure what procedure to take when the operating instructions given in this manual have been followed.

1.2 Notational Descriptions

The following subsections describe notational conventions used in this document.

**Notes, Cautions and Warnings**
Throughout this guide, blocks of text may be accompanied by an icon and printed in bold or italic type. These blocks contain notes, cautions or warnings. They are used as follows:

**Note**
This icon indicates important information and tips that help you make better use of your computer system.

**Caution**
This icon indicates information that tells you how to avoid either potential damage to hardware or loss of data.

**Warning**
This icon indicates the potential for bodily harm and tells you how to avoid the problem. Some warnings may appear in alternate formats and may not be accompanied by an icon. In such cases, the specific presentation of the warning is mandated by the relevant regulatory authority.
1. Important

1.3 Disposal of product and packing material

Waste Electrical and Electronic Equipment-WEEE

This marking on the product or on its packaging illustrates that, under European Directive 2012/19/EU governing used electrical and electronic appliances, this product may not be disposed of with normal household waste. You are responsible for disposal of this equipment through a designated waste electrical and electronic equipment collection. To determine the locations for dropping off such waste electrical and electronic, contact your local government office, the waste disposal organization that serves your household or the store at which you purchased the product.

Your new monitor contains materials that can be recycled and reused. Specialized companies can recycle your product to increase the amount of reusable materials and to minimize the amount to be disposed of.

All redundant packing material has been omitted. We have done our utmost to make the packaging easily separable into mono materials.

Please find out about the local regulations on how to dispose of your old monitor and packing from your sales representative.

Taking back/Recycling Information for Customers

Philips establishes technically and economically viable objectives to optimize the environmental performance of the organization’s product, service and activities.

From the planning, design and production stages, Philips emphasizes the important of making products that can easily be recycled. At Philips, end-of-life management primarily entails participation in national take-back initiatives and recycling programs whenever possible, preferably in cooperation with competitors, which recycle all materials (products and related packaging material) in accordance with all Environmental Laws and taking back program with the contractor company.

Your display is manufactured with high quality materials and components which can be recycled and reused.

To learn more about our recycling program please visit http://www.philips.com/sites/philipsglobal/about/sustainability/ourevironment/productrecyclingservices.page
2. Setting up the monitor

2.1 Installation

1. Package contents

- Power
- SmartKeypad
- USB cable
- VGA
- Dual-link DVI (optional)

2. Install base stand

1. Place the monitor face down on soft and smooth surface taking care to avoid scratching or damaging the screen.

2. Snap in the base in the VESA mount area.
2. Setting up the monitor

3 Connecting to your PC

1. SmartKeypad input
2. DisplayPort
3. VGA input
4. DVI input
5. HDMI or MHL input
6. HDMI input
7. HDMI audio output
8. Kensington anti-theft lock
9. USB upstream
10. USB downstream
11. USB fast charger
12. Zero power Switch
13. AC power input

Connect to PC

1. Connect the power cord to the back of the monitor firmly.
2. Turn off your computer and unplug its power cable.
3. Connect the monitor signal cable to the video connector on the back of your computer.
4. Plug the power cord of your computer and your monitor into a nearby outlet.
5. Turn on your computer and monitor. If the monitor displays an image, installation is complete.

4 Connect the SmartKeypad to your monitor

Connect SmartKeypad to the SmartKeypad port which is on the rear of the display.

Note

1. The SmartKeypad is functional for Philips 242G5DJEB, do not connect to other devices.
2. The SmartKeypad port on rear of the the 242G5DJEB display is design for SmartKeypad only.

2.2 Operating the monitor

1 Front view product description

Connect the SmartKeypad to your monitor

Connect SmartKeypad to the SmartKeypad port which is on the rear of the display.

Switch monitor's power ON and OFF.

Access the OSD menu.

Adjust the OSD menu.

SmartSize: Change display format.

Change the signal input source.

Return to previous OSD level.

Smartimage GAME: There are six modes to select: FPS, Racing, RTS, Gamer1, Gamer2, and Off.
2. Setting up the monitor

2. Description of the SmartKeypad

You are engaged in immersive gaming. You need quick access to your favorite settings without having to take your eyes off the screen. The Philips SmartKeypad enables you to do just that. With its 2x preset buttons, it enables you to customize and save your favorite settings for gaming. It also conveniently allows you to control the menu for quick OSD access and quick select various settings.

![SmartKeypad](image)

1. **Smartimage** \(^{GAME}\)/ Gamer 1 mode.
2. **Smartimage** \(^{GAME}\)/ Gamer 2 mode.
3. Return to previous OSD level.
4. Adjust the OSD menu.
5. Access the OSD menu / Confirm the OSD adjustment.

Note

refer to page 11 “Customize Smartimage \(^{GAME}\)/ Gamer1/ Gamer2 mode” to set Gamer1/ Gamer2 mode”

3. Description of the On Screen Display

What is On-Screen Display (OSD)?

On-Screen Display (OSD) is a feature in all Philips LCD monitors. It allows an end user to adjust screen performance or select functions of the monitors directly through an on-screen instruction window. A user-friendly on-screen display interface is shown as below:

Basic and simple instruction on the control keys

In the OSD shown above, you can press \(\blacktriangledown\)/\(\blacktriangleup\) buttons at the front bezel of the monitor to move the cursor, and press OK button to confirm the choice or change.

The OSD Menu

Below is an overall view of the structure of the On-Screen Display. You can use this as a reference when you want to work your way around the different adjustments later on.
2. Setting up the monitor

3. Resolution notification
This monitor is designed for optimal performance at its native resolution, 1920×1080@60Hz. When the monitor is powered on at a different resolution, an alert is displayed on screen: Use 1920×1080@60Hz for best results.

Display of the native resolution alert can be switched off from Setup in the OSD (On Screen Display) menu.

4. Physical Function

Tilt

Swivel

Height adjustment

Pivot
2. Setting up the monitor

2.3 Remove the Base Assembly for VESA Mounting

Before you start disassembling the monitor base, please follow the instructions below to avoid any possible damage or injury.

1. Place the monitor face down on a smooth surface. Pay attention not to scratch or damage the screen.

2. Remove the screws from hinge cover.

Note
This monitor accepts a 100mm × 100mm mounting interface.

2.4 MHL (Mobile High-Definition Link) introduction

1 What is it?
Mobile High Definition Link (MHL) is a mobile audio/video interface for directly connecting mobile phones and other portable devices to high-definition displays.

An optional MHL cable allows you to simply connect your MHL capable mobile device to this large Philips MHL display, and watch your HD videos come to life with full digital sound. Now not only you can enjoy your mobile games, photos, movies, or other apps on its big screen, you can simultaneously charge your mobile device so you never run out of power half way.

2 How do I use the MHL function?
To use the MHL function, you need an MHL-Certified mobile device. To find a list of MHL-certified devices, visit the official MHL website (http://www.mhlconsortium.org)

You also need a optional MHL certified special cable in order to use this function.

3 How does it work? (how do I connect?)
Connect the Optional MHL cable to the mini USB port on the mobile device side, and the [MHL-HDMI] marked port on the monitor side. You are now ready to view the images on your big screen display and operate all function on you the mobile device such as internet surfing, game playing, photo browsing…etc. if your monitor has speaker function, then you will be able to hear accompanying sound too. When the MHL cable is disconnected or the mobile device is turned off, the MHL function will be automatically disabled.
Note

1. The port marked [MHL-HDMI] is the only port on the monitor that supports the MHL function when the MHL cable is used. Note that the MHL certified cable is different than a standard HDMI cable.

2. A mobile device with MHL certification must be purchased separately.

3. You may have to manually switch the monitor to MHL-HDMI mode in order to activate the monitor, if you have other devices already working and connected to available inputs.

4. Standby/Off energy saving of ErP is not applicable for the MHL charging functionality.

5. Requires optional MHL certified mobile device and MHL cable. (not included) please check with your MHL device vendor for compatibility.
3. Image Optimization

3.1 SmartImageGAME

1. What is it?
SmartImageGAME provides presets that optimize display for different types of gaming content, dynamically adjusting brightness, contrast, color and sharpness in real time. Philips SmartImageGAME delivers great optimized gaming performance.

2. Why do I need it?
You want a monitor that delivers optimized display all your favorite types of gaming content, SmartImageGAME software dynamically adjust brightness, contrast, color and sharpness in real time to enhance your monitor viewing experience.

3. How does it work?
SmartImageGAME is an exclusive, leading edge Philips technology that analyzes the gaming content displayed on your screen. Based on a scenario you select, SmartImageGAME dynamically enhances the contrast, color saturation and sharpness of images to enhance the contents being displayed - all in real time with the press of a single button.

4. How to enable SmartImageGAME?

1. Press □ to launch the SmartImageGAME on screen display.
2. Keep pressing ▼▲ to toggle among FPS, Racing, RTS, Gamer1, Gamer2, or Off.

3. The SmartImageGAME on screen display will remain on screen for 5 seconds, or you can also press "OK" to make confirmation.

There are six modes to select: FPS, Racing, RTS, Gamer1, Gamer2, and Off.

- FPS: For playing FPS (First Person Shooters) games. Improves dark theme black level details.
- Racing: For playing Racing games. Provides fastest response time and high color saturation.
- RTS: For playing RTS (Real Time Strategy) games, a user-selected portion can be highlighted for RTS games (through SmartFrame). The picture quality can be adjusted for the highlighted portion.
- Off: No optimization by SmartImageGAME.

5. Customize SmartImageGAME Gamer1/Gamer2 mode.
This will allow you to create and select your own preference settings.

1. You have to select Gamer1 or Gamer2 first. There are two ways:
   - Click the icon "1" or "2" on the SmartKeypad, SmartImageGAME menu will
pop up on the screen and remain on Gamer1 or Gamer2 which you selected.

- select from the hot key on the front bezel by pressing Smartimage $^\text{GAME}$ and keep pressing “▲ ▼” to select.

2. Click “Ok” on SmartKeypad or by pressing hot key on the front bezel.

3. Go to OSD menu by clicking on SmartKeypad or pressing hot key $^\text{Menu}$ on the front bezel to adjust your preferred mode. Once you finish the adjustment, your preferred mode setting is done and saved automatically after exiting the OSD menu.

**Note**

Gamer mode customization items are:

**Picture**

1. Brightness
2. Contrast
3. Sharpness
4. SmartResponse
5. SmartContrast
6. SmartFrame
7. Over Scan (HDMI source only)

**SmartSize**

1. Panel Size
2. 1:1
3. Aspect

**Audio**

1. Volume
2. Mute
3. Audio Source

**Color**

1. Color Temperature
2. sRGB
3. User Define
3. Image Optimization

3.2 SmartContrast

1 What is it?
Unique technology that dynamically analyzes displayed content and automatically optimizes a Monitor’s contrast ratio for maximum visual clarity and viewing enjoyment, stepping up backlighting for clearer, crisper and brighter images or dimming backlighting for clear display of images on dark backgrounds.

2 Why do I need it?
You want the very best visual clarity and viewing comfort for every type of content. SmartContrast dynamically controls contrast and adjusts backlighting for clear, crisp, bright gaming and video images or displays clear, readable text for office work. By reducing your monitor’s power consumption, you save on energy costs and extend the lifetime of your monitor.

3 How does it work?
When you activate SmartContrast, it will analyse the content you are displaying in real time to adjust colors and control backlight intensity. This function will dynamically enhance contrast for a great entertainment experience when viewing videos or playing games.

3.3 Philips SmartControl

The new SmartControl software by Philips allows you to control your monitor via an easy to use on-screen graphic interface. Complicated adjustments are a thing of the past as this user-friendly software guides you through fine-tuning resolution, Color calibration, Clock/Phase adjustments, RGB White point adjustment, etc.

Equipped with latest technology in core algorithm for fast processing and response, this Windows 7 compliant eye catching animated Icon based software is ready to enhance your experience with Philips monitors!
3. Image Optimization

2. Start with Standard pane

Adjust menu

- Adjust Menu allow you to adjust Brightness, Contrast, Focus, Position and Resolution.
- You can follow the instruction and do the adjustment.
- Cancel prompts user if you want to cancel installation.
3. Image Optimization

**Color menu**

- Color Menu allow you to adjust RGB, Black Level, White Point, Color Calibration, and SmartImage (Please refer to SmartImage section).
- You can follow the instruction and do the adjustment.
- Refer to below table for sub-menu item base on your input.
- Example for Color Calibration.

**First Color Calibration Screen**

1. "Show Me" starts color calibration tutorial.
2. Start - starts the 6-step color calibration sequence.
3. Quick View loads the before/after images.
4. To return to Color home pane, click the Cancel button.
5. Enable color calibration - by default is on. If unchecked, does not allow for color calibration to happen, dimes out start and quick view buttons.
6. Must have patent info in calibration screen.
3. Image Optimization

- Previous button is disabled until the second color screen.
- Next goes to the succeeding target (6-targets).
- Finally go to File > Presets pane.
- Cancel closes the UI and returns to the plug in page.

**SmartImage**

Allows user to change setting for better display setting based on content.

**ECO menu**

**Options menu**

Theft Deterrence Pane will only be active when selecting Theft Deterrence Mode from the drop-down Plug Ins menu.

To enable Theft Deterrence, clicking Enable Theft Deterrence Mode button brings up the following screen:

- User can enter PIN between 4 and 9 digits numbers only.
- After entering PIN, Accept button takes user to the pop-up dialog box on the following page.
3. Image Optimization

- Minimum minutes set to 5. Slider set to 5 by default.
- Does not require the display be attached to a different host to go into Theft Deterrence mode.

After creating PIN, the Theft Deterrence pane will indicate Theft Deterrence Enabled and provide PIN Options button:

- Theft Deterrence Enabled is displayed.
- Disable Theft Deterrence Mode opens pane screen on next page.
- PIN Options button only available after user creates PIN, button opens secure PIN web site.

Options>Preferences - Will only be active when selecting Preferences from the drop-down Options menu. On a non-supported display capable of DDC/CI, only the Help and Options tabs are available.

- Displays current preference settings.
- A checked box enables the feature. The check box is a toggle.
- Enable Context Menu on desktop is checked (On) by default. Enable Context menu displays SmartControl selections for Select Preset and Tune Display in the desktop right-click context menu. Disabled removes SmartControl from the right click context menu.
- Enable Task Tray icon is checked (On) by default. Enable context menu shows the task tray menu for SmartControl. A right click on the task tray icon displays the menu options for Help, Technical Support. Check for Update, About, and Exit. When Enable task tray menu is disabled, the task tray icon will only display EXIT.
- Run at Startup is checked (On) by default. When disabled, SmartControl will not launch at start or be in the task tray. The only way to launch SmartControl is either from the desktop short cut or from the program file. Any preset set to run at startup will not load when this box is unchecked (Disabled).
- Enable transparency mode (Windows 7, Vista, XP). Default is 0% Opaque.

Options>Input - Will only be active when selecting Input from the drop-down Options menu. On a non-supported display capable of DDC/CI, only the Help and Options tabs are available. All other SmartControl tabs are not available.

- Display the Source instruction pane and current input source setting.
- On single input displays, this pane will not be visible.

Options<Audio - Will only be active when selecting Audio from the drop-down Options menu.
3. Image Optimization

On a non-supported display capable of DDC/CI, only the Help and Options tabs are available.

**Option>Auto Pivot**

**Help menu**

Help>User Manual - Will only be active when selecting User Manual from the drop-down Help menu. On a non-supported display capable of DDC/CI, only the Help and Options tabs are available.

**Context Sensitive menu**

The Context Sensitive menu is Enabled by default. If Enable Context Menu has been checked in the Options>Preferences pane, then the menu will be visible.
The Context Menu has four entries:

- **SmartControl** - When selected the About screen is displayed.
- **Select Preset** - Provides a hierarchical menu of saved presets for immediate use. A check mark shows the currently selected preset. Factory Preset can also be called from the drop-down menu.
- **Tune Display** - Opens the SmartControl control panel.
- **SmartImage** - Check current settings: Off, FPS, Racing, RTS, Gamer1, Gamer2.

**Task Tray Menu Enabled**

The task tray menu can be displayed by right-clicking on the SmartControl icon from the task tray. Left Click will launch the application.

- **Check for Update** - Takes the user to PDI Landing and checks the user's version against the most current available.
- **About** - Displays detailed reference information: product version, release information, and product name.
- **Exit** - Close SmartControl.

To run SmartControl again, either select SmartControl from Program menu, double-click the desktop PC icon, or restart the system.

**Task Tray Menu Disabled**

When the Task Tray is disabled in the preference folder, only the Exit selection is available. To completely remove SmartControl from the task tray, disable Run at Startup in Options>Preferences.

**Note**

All the illustrations in this section are for reference only. SmartControl software version might be changed without notification. Please always check official Portrait website [www.portrait.com/dtune/phl/enu/index](http://www.portrait.com/dtune/phl/enu/index) to download the latest version of SmartControl software.

The task tray has five entries:

- **Technical Support** - Displays the tech support page.
## 4. Technical Specifications

<table>
<thead>
<tr>
<th><strong>Picture/Display</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Monitor Panel Type</td>
<td>TN LCD</td>
</tr>
<tr>
<td>Backlight</td>
<td>LED</td>
</tr>
<tr>
<td>Panel Size</td>
<td>24&quot; W (61cm)</td>
</tr>
<tr>
<td>Aspect Ratio</td>
<td>16:9</td>
</tr>
<tr>
<td>Pixel Pitch</td>
<td>0.277 x 0.277 mm</td>
</tr>
<tr>
<td>Brightness</td>
<td>350 cd/m²</td>
</tr>
<tr>
<td>SmartContrast</td>
<td>80,000,000:1</td>
</tr>
<tr>
<td>Contrast Ratio (typ.)</td>
<td>1000:1</td>
</tr>
<tr>
<td>Response Time (typ.)</td>
<td>5ms</td>
</tr>
<tr>
<td>SmartResponse</td>
<td>1ms</td>
</tr>
<tr>
<td>Maximum Resolution</td>
<td>1920x1080@144Hz (Dual-link DVI/ DP)</td>
</tr>
<tr>
<td>Optimum Resolution</td>
<td>1920x1080@120Hz (Dual-link DVI/ DP)</td>
</tr>
<tr>
<td>Standard Resolution</td>
<td>1920x1080@60Hz (VGA, HDMI, Dual-link DVI, DP)</td>
</tr>
<tr>
<td>Viewing Angle</td>
<td>170° (H) / 160° (V) @ C/R &gt; 10</td>
</tr>
<tr>
<td>Picture Enhancement</td>
<td>Smartimage</td>
</tr>
<tr>
<td>Display Colors</td>
<td>16.7M</td>
</tr>
<tr>
<td>Vertical Refresh Rate</td>
<td>56Hz - 120Hz</td>
</tr>
<tr>
<td>Horizontal Frequency</td>
<td>30kHz - 144kHz</td>
</tr>
<tr>
<td>sRGB</td>
<td>YES</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Connectivity</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Signal Input</td>
<td>VGA (Analog), Dual-link DVI (Digital, HDCP), USB 3.0 x4, SmartKeypad port, HDMI (Digital, HDCP), MHL-HDMI (Digital, HDCP), Display Port</td>
</tr>
<tr>
<td>Audio In/Out</td>
<td>HDMI audio out</td>
</tr>
<tr>
<td>Input Signal</td>
<td>Separate Sync, Sync on Green</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Convenience</strong></th>
<th>1 2 🎮 ▲ ▼ ⏯/OK</th>
</tr>
</thead>
<tbody>
<tr>
<td>SmartKeypad</td>
<td></td>
</tr>
<tr>
<td>User Convenience</td>
<td></td>
</tr>
<tr>
<td>OSD Languages</td>
<td>English, French, German, Spanish, Italian, Russian, Simplified Chinese, Portuguese, Turkish, Dutch, Swedish, Finnish, Polish, Czech, Korean, Japanese, Hungarian, Ukrainian, Brazilian Portuguese, Greek (optional), Traditional Chinese (optional)</td>
</tr>
<tr>
<td>Other Convenience</td>
<td>Kensington Lock</td>
</tr>
<tr>
<td>Plug &amp; Play Compatibility</td>
<td>DDC/CI, sRGB, Windows 7/Windows 8, Mac OSX, Linux</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Stand</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Tilt</td>
<td>-5° / +20°</td>
</tr>
<tr>
<td>Swivel</td>
<td>-65/+65</td>
</tr>
<tr>
<td>Height adjustment</td>
<td>130 mm</td>
</tr>
<tr>
<td>Pivot</td>
<td>90 degree</td>
</tr>
</tbody>
</table>
## 4. Technical Specifications

### Power

<table>
<thead>
<tr>
<th>Mode</th>
<th>Power Consumption</th>
</tr>
</thead>
<tbody>
<tr>
<td>On Mode</td>
<td>35.76W (typ.), 62.47W (max.)</td>
</tr>
<tr>
<td>Sleep (typ.)</td>
<td>0.5W</td>
</tr>
<tr>
<td>Off (typ.)</td>
<td>0.3W</td>
</tr>
<tr>
<td>Power LED indicator</td>
<td>On mode: White, Standby/Sleep mode: White (blinking)</td>
</tr>
<tr>
<td>Power Supply</td>
<td>100-240VAC, 50-60Hz</td>
</tr>
</tbody>
</table>

### Dimension

<table>
<thead>
<tr>
<th>Description</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product with stand (WxHxD)</td>
<td>565 x 517 x 220 mm</td>
</tr>
<tr>
<td>Product without stand (WxHxD)</td>
<td>565 x 354 x 63 mm</td>
</tr>
</tbody>
</table>

### Weight

<table>
<thead>
<tr>
<th>Description</th>
<th>Weight</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product with stand</td>
<td>6.265 kg</td>
</tr>
<tr>
<td>Product without stand</td>
<td>4.125 kg</td>
</tr>
<tr>
<td>Product with packaging</td>
<td>8.833 kg</td>
</tr>
</tbody>
</table>

### Operating Condition

<table>
<thead>
<tr>
<th>Condition</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temperature range (operation)</td>
<td>0°C to 40 °C</td>
</tr>
<tr>
<td>Temperature range (Non-operation)</td>
<td>-20°C to 60°C</td>
</tr>
<tr>
<td>Relative humidity</td>
<td>20% to 80%</td>
</tr>
<tr>
<td>MTBF</td>
<td>30,000hrs</td>
</tr>
</tbody>
</table>

### Environmental

<table>
<thead>
<tr>
<th>Description</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>ROHS</td>
<td>YES</td>
</tr>
<tr>
<td>EPEAT</td>
<td>Silver (<a href="http://www.epeat.net">www.epeat.net</a>)</td>
</tr>
<tr>
<td>Packaging</td>
<td>100% recyclable</td>
</tr>
<tr>
<td>Specific Substances</td>
<td>100% PVC BFR free housing</td>
</tr>
<tr>
<td>Energy Star</td>
<td>YES</td>
</tr>
</tbody>
</table>

### Compliance and standards

<table>
<thead>
<tr>
<th>Approvals</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Regulatory Approvals</td>
<td>CE Mark, FCC Class B, CU-EAC, SEMKO, TCO Certified, ETL</td>
</tr>
</tbody>
</table>

### Cabinet

<table>
<thead>
<tr>
<th>Description</th>
<th>Color</th>
<th>Finish</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Black</td>
<td>Texture</td>
</tr>
</tbody>
</table>

---

### Note

1. EPEAT Gold or Silver is valid only where Philips registers the product. Please visit [www.epeat.net](http://www.epeat.net) for registration status in your country.

2. This data is subject to change without notice. Go to [www.philips.com/support](http://www.philips.com/support) to download the latest version of leaflet.
### 4.1 Resolution & Preset Modes

Maximum Resolution: 1920x1080@ 144Hz (Dual-link DVI/ DP)
Optimum Resolution: 1920x1080@ 120Hz (Dual-link DVI/ DP)
Standard resolution: 1920x1080@ 60Hz(VGA, HDMI, Dual-link DVI, DP)

<table>
<thead>
<tr>
<th>H. freq (kHz)</th>
<th>Resolution</th>
<th>V. freq (Hz)</th>
</tr>
</thead>
<tbody>
<tr>
<td>31.47</td>
<td>720x400</td>
<td>70.09</td>
</tr>
<tr>
<td>31.47</td>
<td>640x480</td>
<td>59.94</td>
</tr>
<tr>
<td>35.00</td>
<td>640x480</td>
<td>66.67</td>
</tr>
<tr>
<td>37.86</td>
<td>640x480</td>
<td>72.81</td>
</tr>
<tr>
<td>37.50</td>
<td>640x480</td>
<td>75.00</td>
</tr>
<tr>
<td>60.94</td>
<td>640x480</td>
<td>119.72</td>
</tr>
<tr>
<td>37.88</td>
<td>800x600</td>
<td>60.32</td>
</tr>
<tr>
<td>46.88</td>
<td>800x600</td>
<td>75.00</td>
</tr>
<tr>
<td>76.30</td>
<td>800x600</td>
<td>119.97</td>
</tr>
<tr>
<td>48.36</td>
<td>1024x768</td>
<td>60.00</td>
</tr>
<tr>
<td>60.02</td>
<td>1024x768</td>
<td>75.03</td>
</tr>
<tr>
<td>97.55</td>
<td>1024x768</td>
<td>119.99</td>
</tr>
<tr>
<td>63.89</td>
<td>1280x1024</td>
<td>60.02</td>
</tr>
<tr>
<td>79.98</td>
<td>1280x1024</td>
<td>75.03</td>
</tr>
<tr>
<td>55.94</td>
<td>1440x900</td>
<td>59.89</td>
</tr>
<tr>
<td>70.64</td>
<td>1440x900</td>
<td>74.98</td>
</tr>
<tr>
<td>114.22</td>
<td>1440x900</td>
<td>119.85</td>
</tr>
<tr>
<td>65.29</td>
<td>1680x1050</td>
<td>59.95</td>
</tr>
<tr>
<td>67.50</td>
<td>1920x1080</td>
<td>60.00</td>
</tr>
<tr>
<td>137.26</td>
<td>1920x1080</td>
<td>119.98</td>
</tr>
<tr>
<td>158.11</td>
<td>1920x1080</td>
<td>144.00</td>
</tr>
</tbody>
</table>

**Note**

1. This Philips display is capable of achieving upto 144Hz refresh rates thru its Dual-link DVI connector only.
   Please ensure your graphics card is capable of 144Hz refresh rates and updated with the latest driver.
2. For any questions related to 144Hz performance please refer to your card vendor directly.
5. Power Management

If you have VESA DPM compliance display card or software installed in your PC, the monitor can automatically reduce its power consumption when not in use. If an input from a keyboard, mouse or other input device is detected, the monitor will 'wake up' automatically. The following table shows the power consumption and signaling of this automatic power saving feature:

<table>
<thead>
<tr>
<th>VESA Mode</th>
<th>Video</th>
<th>H-sync</th>
<th>V-sync</th>
<th>Power Used</th>
<th>LED Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>ON</td>
<td>Yes</td>
<td>Yes</td>
<td>35.76W (typ.), 62.47W (max.)</td>
<td>White</td>
</tr>
<tr>
<td>Sleep</td>
<td>OFF</td>
<td>No</td>
<td>No</td>
<td>0.5 W (typ.)</td>
<td>White (blink)</td>
</tr>
<tr>
<td>Switch Off</td>
<td>OFF</td>
<td>-</td>
<td>-</td>
<td>0.3 W (typ.)</td>
<td>OFF</td>
</tr>
</tbody>
</table>

The following setup is used to measure power consumption on this monitor:

- Native resolution: 1920x1080
- Contrast: 50%
- Brightness: 350 nits
- Color temperature: 6500k with full white pattern

Note
This data is subject to change without notice.
6. Regulatory Information

Lead-free Product

Lead-free display promotes environmentally sound recovery and disposal of waste from electrical and electronic equipment. Toxic substances like Lead has been eliminated and compliance with European community’s stringent RoHs directive mandating restrictions on hazardous substances in electrical and electronic equipment have been adhered to in order to make Philips monitors safe to use throughout its life cycle.

Congratulations!
This product is designed for both you and the planet!

TCO Development works for sustainable IT - manufacture, use and recycling of IT products reflecting environmental, social and economic responsibility.

TCO Certified is a third party verified program, where every product model is tested by an accredited impartial test laboratory. TCO Certified represents one of the toughest certifications for ICT products worldwide.

Some of the Usability features of TCO Certified Displays:

• Visual Ergonomics for image quality is tested to ensure top performance and reduce sight and strain problems. Important parameters are Resolution, Luminance, Contrast, Reflection and Colour characteristics
• Products are tested according to rigorous safety standards at impartial laboratories
• Electric and magnetic fields emissions as low as normal household background levels
• Workload ergonomics to ensure a good physical environment

Some of the Environmental features of TCO Certified Displays:

• Production facilities have an Environmental Management System (EMAS or ISO 14001)
• Low energy consumption to minimize climate impact
• Restrictions on Chlorinated and Brominated flame retardants, plasticizers, plastics and heavy metals such as cadmium, mercury and lead (RoHS compliance)
• Both product and product packaging is prepared for recycling
• The brand owner offers take-back options

Corporate Social Responsibility

• The brand owner demonstrates the product is manufactured under working practices that promote good labour relations and working conditions.

The Criteria Document can be downloaded from our web site. The criteria included in this label have been developed by TCO Development in co-operation with scientists, experts, users as well as manufacturers all over the world. Since the end of the 1980s TCO has been involved in influencing the development of IT equipment in a more user and environmentally friendly direction. Our ICT product labeling system began in 1992 and is now requested by users and ICT-manufacturers all over the world.

For displays with glossy bezels, the user should consider the placement of the display as the bezel may cause disturbing reflections from surrounding light and bright surfaces.

For more information, please visit: www.tcodevelopment.com

(Only for selective models)

User mode is used for TCO Certified compliance.
6. Regulatory Information

EPEAT

(www.epeat.net)

The EPEAT (Electronic Product Environmental Assessment Tool) program evaluates computer desktops, laptops, and monitors based on 51 environmental criteria developed through an extensive stakeholder consensus process supported by US EPA.

EPEAT system helps purchasers in the public and private sectors evaluate, compare and select desktop computers, notebooks and monitors based on their environmental attributes. EPEAT also provides a clear and consistent set of performance criteria for the design of products, and provides an opportunity for manufacturers to secure market recognition for efforts to reduce the environmental impact of its products.

Benefits of EPEAT
Reduce use of primary materials
Reduce use of toxic materials
Avoid the disposal of hazardous waste EPEAT’S requirement that all registered products meet ENERGY STAR’s energy efficiency specifications, means that these products will consume less energy throughout their life.

CE Declaration of Conformity
This product is in conformity with the following standards

- EN50581:2012 (Limitation of Voltage Fluctuation and Flicker) following provisions of directives applicable.
- EN50581:2012 (Technical documentation for the assessment of electrical and electronic products with respect to the restriction of hazardous substances).
- EN 50564:2011 (Electrical and electronic household and office equipment — Measurement of low power consumption).
- 2006/95/EC (Low Voltage Directive).
- 2011/65/EU (RoHS Directive).

And is produced by a manufacturing organization on ISO9000 level.

6. Regulatory Infomation

Energy Star Declaration
(www.energystargov)

As an ENERGY STAR® Partner, we have determined that this product meets the ENERGY STAR® guidelines for energy efficiency.

Note
We recommend you switch off the monitor when it is not in use for a long time.

Federal Communications Commission (FCC) Notice (U.S. Only)

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications.

However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

⚠ Changes or modifications not expressly approved by the party responsible for compliance could void the user’s authority to operate the equipment.

Use only RF shielded cable that was supplied with the monitor when connecting this monitor to a computer device.

To prevent damage which may result in fire or shock hazard, do not expose this appliance to rain or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS ALL REQUIREMENTS OF THE CANADIAN INTERFERENCE-CAUSING EQUIPMENT REGULATIONS.

FCC Declaration of Conformity
Declaration of Conformity for Products Marked with FCC Logo,

United States Only

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Commission Federale de la Communication (FCC Declaration)

Cet équipement a été testé et déclaré conforme aux limites des appareils numériques de class B,aux termes de l'article 15 Des règles de la FCC. Ces limites sont conçues de façon à fournir une protection raisonnable contre les interférences nuisibles dans le cadre d'une installation résidentielle.

CET appareil produit, utilise et peut émettre des hyperfréquences qui, si l'appareil n'est pas installé et utilisé selon les consignes données, peuvent causer des interférences nuisibles aux communications radio.
Cependant, rien ne peut garantir l’absence d’interférences dans le cadre d’une installation particulière. Si cet appareil est la cause d’interférences nuisibles pour la réception des signaux de radio ou de télévision, ce qui peut être décelé en fermant l’équipement, puis en le remettant en fonction, l’utilisateur pourrait essayer de corriger la situation en prenant les mesures suivantes:

- Réorienter ou déplacer l’antenne de réception.
- Augmenter la distance entre l’équipement et le récepteur.
- Brancher l’équipement sur un autre circuit que celui utilisé par le récepteur.
- Demander l’aide du marchand ou d’un technicien chevronné en radio/télévision.

Toutes modifications n’ayant pas reçu l’approbation des services compétents en matière de conformité est susceptible d’interdire à l’utilisateur l’usage du présent équipement.

N’utiliser que des câbles RF armés pour les connections avec des ordinateurs ou périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE B RESPECTE TOUTES LES EXIGENCES DU REGLEMENT SUR LE MATERIEL BROUILLEUR DU CANADA.

EN 55022 Compliance (Czech Republic Only)

This device belongs to category B devices as described in EN 55022. Unless it is specifically stated that it is a Class A device on the specification label, the following applies to devices of Class A in the European Union (EU):

The user is authorized to operate the equipment in accordance with the protection requirements of standards PN-93/T-42107 and PN-89/E-06251.

Polish Center for Testing and Certification Notice

The equipment should draw power from a socket with an attached protection circuit (a three-prong socket). All equipment that works together (computer, monitor, printer, and so on) should have the same power supply source.

The phasing conductor of the room’s electrical installation should have a reserve short-circuit protection device in the form of a fuse with a nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the power supply cable must be removed from the power supply socket, which should be located near the equipment and easily accessible.

A protection mark “B” confirms that the equipment is in compliance with the protection usage requirements of standards PN-93/T-42107 and PN-89/E-06251.

Wymagania Polskiego Centrum Badań i Certyfikacji

Urządzenie powinno być zainstalowane w pobliżu urządzenia ochrony (drzwi zamek). W przypadku sprzętu obsłudzającego, w tym komputeru, monitora, drukarki, powinny być zainstalowane w ich bezpośredniej okolicy.

Instalacja elektroinstalacji powinna być wykonana zgodnie z przepisami ijlawami normatywnymi dla urządzeń elektrycznych.

W celu ochrony przed uszkodzeniem sprzętu w czasie zasilania, należy użyć jednokoncowego kabla zasilającego, który powinien być zainstalowany w pobliżu urządzenia.

Zakres bezpieczeństwa "B" powinien pokrywać urządzenia z wymaganiami bezpieczeństwa zgodnymi z PN-93/T-42107 i PN-89/E-06251.

Pozostałe instrukcje bezpieczeństwa

- W celu uniknięcia wypadków użytkownicy komputerów mogą wkomponować podłączenie ochronne do elektrycznego sprzętu ochronnego, z których jest to konieczne w przypadku podłączenia do sieci elektrycznej zgodnie z przewodami elektrycznymi lub systemami elektrycznymi.
- System komputerowy nie powinien być podłączony do sieci elektrycznej lub systemów elektrycznych w sposób umożliwiający ich wyprowadzanie z zasilania elektrycznego.
- Należy upewnić się, aby nie wchodzić na kable systemu komputerowego, które mogą być podłączone do sieci elektrycznej lub other systemów elektrycznych.
- Należy zainstalować ochrony ani innych ochron na system komputerowy.
- Należy w przypadku zanieczyszczenia podłączeniowe systemu komputerowego, aby nie mogły być podłączone do sieci elektrycznych.
- System komputerowy powinien być zainstalowany w pobliżu grafików i przenośników. Ponadto, nie należy blokować obwodów w rozłącznikach. Należy również zainstalować podłączenia do innych systemów elektrycznych i w przypadku zanieczyszczenia podłączeniowe systemu komputerowego, aby nie mogły być podłączone do sieci elektrycznych.
North Europe (Nordic Countries) Information

Placering/Ventilation
WARNING:
FÖRSÄKRA DIG OM ATT HUVUDBRYTARE
OCH UTTag ÄR LÄTÅTKOMLIGA, NÄR,
DU STÄLLER DIN UTRUSTNING PÅPLATS.

Placering/Ventilation
ADVARSEL:
SØRG VED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT
ER NEMT TILGÆNGELIGE.

Paikka/Ilmankierto
VAROITUS:
SIJOITA LAITE SITEN, ETTÄ VERKKOJOHTO
VOIDAA TARVITTAESSA HELPOSTI
IRROTTAA PISTORASIISTA.

Plassering/Ventilasjon
ADVARSEL:
NÅR DETTE UTSTYRET Plasseres, MÅ
DU PASSE PÅ AT KONTAKTENE FOR
STØMTILFØRSEL ER LETTE Å NÅ.

Ergonomie Hinweis (nur Deutschland)
Der von uns gelieferte Farbmonitor entspricht
den in der "Verordnung über den Schutz vor
Schäden durch Röntgenstrahlen" festgelegten
Vorschriften.

Auf der Rückwand des Gerätes befindet sich
ein Aufkleber, der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften
über die Bauart von Störstrahlern nach Anlage
III § 5 Abs. 4 der Röntgenverordnung erfüllt sind.

Damit Ihr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, daß

1. Reparaturen nur durch Fachpersonal
durchgeführt werden.
2. nur original-Ersatzteile verwendet werden.
3. bei Ersatz der Bildröhre nur eine
bauartgleiche eingebaut wird.

Aus ergonomischen Gründen wird empfohlen,
die Grundfarben Blau und Rot nicht auf
dunklem Untergrund zu verwenden (schlechte
Lesbarkeit und erhöhte Augenbelastung bei zu
gerinem Zeichenkontrast wären die Folge).
Der arbeitsplatzbezogene Schalldruckpegel
nach DIN 45 635 beträgt 70dB (A) oder
weniger.

ACHTUNG: BEIM AUFSTELLEN
DIESES GERÄTES DARAU
ACHTEN, DASS NETZSTECKER UND
NETZKABELANSCHLUSS LEICHT
ZUGÄNGLICH SIND.
6. Regulatory Information

China RoHS

The People's Republic of China released a regulation called "Management Methods for Controlling Pollution by Electronic Information Products" or commonly referred to as China RoHS. All products including CRT and Monitor which are produced and sold for China market have to meet China RoHS request.

EU Energy Label

The European Energy Label informs you on the energy efficiency class of this product. The greener the energy efficiency class of this product is the lower the energy it consumes. On the label, you can find the energy efficiency class, the average power consumption of this product in use and the average energy consumption for 1 year.

Note

The EU Energy Label will be ONLY applied on the models bundling with HDMI and TV tuners.
7. Customer care and warranty

7.1 Philips’ Flat Panel Monitors Pixel Defect Policy

Philips strives to deliver the highest quality products. We use some of the industry’s most advanced manufacturing processes and practice stringent quality control. However, pixel or sub pixel defects on the TFT Monitor panels used in flat panel monitors are sometimes unavoidable. No manufacturer can guarantee that all panels will be free from pixel defects, but Philips guarantees that any monitor with an unacceptable number of defects will be repaired or replaced under warranty. This notice explains the different types of pixel defects and defines acceptable defect levels for each type. In order to qualify for repair or replacement under warranty, the number of pixel defects on a TFT Monitor panel must exceed these acceptable levels. For example, no more than 0.0004% of the sub pixels on a monitor may be defective. Furthermore, Philips sets even higher quality standards for certain types or combinations of pixel defects that are more noticeable than others. This policy is valid worldwide.

Pixels and Sub pixels

A pixel, or picture element, is composed of three sub pixels in the primary colors of red, green and blue. Many pixels together form an image. When all sub pixels of a pixel are lit, the three colored sub pixels together appear as a single white pixel. When all are dark, the three colored sub pixels together appear as a single black pixel. Other combinations of lit and dark sub pixels appear as single pixels of other colors.

Types of Pixel Defects

Pixel and sub pixel defects appear on the screen in different ways. There are two categories of pixel defects and several types of sub pixel defects within each category.

Bright Dot Defects

Bright dot defects appear as pixels or sub pixels that are always lit or ‘on’. That is, a bright dot is a sub-pixel that stands out on the screen when the monitor displays a dark pattern. There are the types of bright dot defects.

- One lit red, green or blue sub pixel.

- Two adjacent lit sub pixels:
  - Red + Blue = Purple
  - Red + Green = Yellow
  - Green + Blue = Cyan (Light Blue)

- Three adjacent lit sub pixels (one white pixel).
7. Customer care and warranty

Note
A red or blue bright dot must be more than 50 percent brighter than neighboring dots while a green bright dot is 30 percent brighter than neighboring dots.

Black Dot Defects
Black dot defects appear as pixels or sub pixels that are always dark or 'off'. That is, a dark dot is a sub-pixel that stands out on the screen when the monitor displays a light pattern. These are the types of black dot defects.

Proximity of Pixel Defects
Because pixel and sub pixels defects of the same type that are near to one another may be more noticeable, Philips also specifies tolerances for the proximity of pixel defects.

Pixel Defect Tolerances
In order to qualify for repair or replacement due to pixel defects during the warranty period, a TFT Monitor panel in a Philips flat panel monitor must have pixel or sub pixel defects exceeding the tolerances listed in the following tables.

<table>
<thead>
<tr>
<th>BRIGHT DOT DEFECTS</th>
<th>ACCEPTABLE LEVEL</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 lit subpixel</td>
<td>3</td>
</tr>
<tr>
<td>2 adjacent lit subpixels</td>
<td>1</td>
</tr>
<tr>
<td>3 adjacent lit subpixels (one white pixel)</td>
<td>0</td>
</tr>
<tr>
<td>Distance between two bright dot defects*</td>
<td>&gt;15mm</td>
</tr>
<tr>
<td>Total bright dot defects of all types</td>
<td>3</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>BLACK DOT DEFECTS</th>
<th>ACCEPTABLE LEVEL</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 dark subpixel</td>
<td>5 or fewer</td>
</tr>
<tr>
<td>2 adjacent dark subpixels</td>
<td>2 or fewer</td>
</tr>
<tr>
<td>3 adjacent dark subpixels</td>
<td>0</td>
</tr>
<tr>
<td>Distance between two black dot defects*</td>
<td>&gt;15mm</td>
</tr>
<tr>
<td>Total black dot defects of all types</td>
<td>5 or fewer</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>TOTAL DOT DEFECTS</th>
<th>ACCEPTABLE LEVEL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total bright or black dot defects of all types</td>
<td>5 or fewer</td>
</tr>
</tbody>
</table>

Note
1. 1 or 2 adjacent sub pixel defects = 1 dot defect
2. This monitor is ISO9241-307 compliant (ISO9241-307: Ergonomic requirement, analysis and compliance test methods for electronic visual displays)
7. Customer care and warranty

7.2 Customer Care & Warranty

For warranty coverage information and additional support requirement valid for your region, please visit www.philips.com/support website for details. You may also contact your local Philips Customer Care Center number listed below.

Contact Information for WESTERN EUROPE region:

<table>
<thead>
<tr>
<th>Country</th>
<th>CSP</th>
<th>Hotline Number</th>
<th>Price</th>
<th>Opening hours</th>
</tr>
</thead>
<tbody>
<tr>
<td>Austria</td>
<td>RTS</td>
<td>+43 0810 000206</td>
<td>€ 0.07</td>
<td>Mon to Fri : 9am - 6pm</td>
</tr>
<tr>
<td>Belgium</td>
<td>Ecare</td>
<td>+32 078 250851</td>
<td>€ 0.06</td>
<td>Mon to Fri : 9am - 6pm</td>
</tr>
<tr>
<td>Cyprus</td>
<td>Alman</td>
<td>800 92 256</td>
<td>Free of charge</td>
<td>Mon to Fri : 9am - 6pm</td>
</tr>
<tr>
<td>Denmark</td>
<td>Infocare</td>
<td>+45 3525 8761</td>
<td>Local call tariff</td>
<td>Mon to Fri : 9am - 6pm</td>
</tr>
<tr>
<td>Finland</td>
<td>Infocare</td>
<td>+358 09 2290 1908</td>
<td>Local call tariff</td>
<td>Mon to Fri : 9am - 6pm</td>
</tr>
<tr>
<td>France</td>
<td>Mainteq</td>
<td>+33 082161 1658</td>
<td>€ 0.09</td>
<td>Mon to Fri : 9am - 6pm</td>
</tr>
<tr>
<td>Germany</td>
<td>RTS</td>
<td>+49 01803 386 853</td>
<td>€ 0.09</td>
<td>Mon to Fri : 9am - 6pm</td>
</tr>
<tr>
<td>Greece</td>
<td>Alman</td>
<td>+30 00800 3122 1223</td>
<td>Free of charge</td>
<td>Mon to Fri : 9am - 6pm</td>
</tr>
<tr>
<td>Ireland</td>
<td>Celestica</td>
<td>+353 01 601 1161</td>
<td>Local call tariff</td>
<td>Mon to Fri : 8am - 5pm</td>
</tr>
<tr>
<td>Italy</td>
<td>Anovo Italy</td>
<td>+39 840 320 041 € 0.08</td>
<td>€ 0.08</td>
<td>Mon to Fri : 9am - 6pm</td>
</tr>
<tr>
<td>Luxembourg</td>
<td>Ecare</td>
<td>+352 26 84 30 00</td>
<td>Local call tariff</td>
<td>Mon to Fri : 9am - 6pm</td>
</tr>
<tr>
<td>Netherlands</td>
<td>Ecare</td>
<td>+31 0900 0400 063</td>
<td>€ 0.10</td>
<td>Mon to Fri : 9am - 6pm</td>
</tr>
<tr>
<td>Norway</td>
<td>Infocare</td>
<td>+47 2270 8250</td>
<td>Local call tariff</td>
<td>Mon to Fri : 9am - 6pm</td>
</tr>
<tr>
<td>Poland</td>
<td>MSI</td>
<td>+48 0223491505</td>
<td>Local call tariff</td>
<td>Mon to Fri : 9am - 6pm</td>
</tr>
<tr>
<td>Portugal</td>
<td>Mainteq</td>
<td>800 780 902</td>
<td>Free of charge</td>
<td>Mon to Fri : 8am - 5pm</td>
</tr>
<tr>
<td>Spain</td>
<td>Mainteq</td>
<td>+34 902 888 785</td>
<td>€ 0.10</td>
<td>Mon to Fri : 9am - 6pm</td>
</tr>
<tr>
<td>Sweden</td>
<td>Infocare</td>
<td>+46 08 632 0016</td>
<td>Local call tariff</td>
<td>Mon to Fri : 9am - 6pm</td>
</tr>
<tr>
<td>Switzerland</td>
<td>ANOVO CH</td>
<td>+41 02 2310 2116</td>
<td>Local call tariff</td>
<td>Mon to Fri : 9am - 6pm</td>
</tr>
<tr>
<td>United Kingdom</td>
<td>Celestica</td>
<td>+44 0207 949 0069</td>
<td>Local call tariff</td>
<td>Mon to Fri : 8am - 5pm</td>
</tr>
</tbody>
</table>
### Contact Information for CENTRAL AND EASTERN EUROPE region:

<table>
<thead>
<tr>
<th>Country</th>
<th>Call center</th>
<th>CSP</th>
<th>Consumer care number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Belarus</td>
<td>N/A</td>
<td>IBA</td>
<td>+375 17 217 3386</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>+375 17 217 3389</td>
</tr>
<tr>
<td>Bulgaria</td>
<td>N/A</td>
<td>LAN Service</td>
<td>+359 2 960 2360</td>
</tr>
<tr>
<td>Croatia</td>
<td>N/A</td>
<td>MR Service Ltd</td>
<td>+385 (01) 640 1111</td>
</tr>
<tr>
<td>Czech Rep.</td>
<td>N/A</td>
<td>Asupport</td>
<td>420 272 188 300</td>
</tr>
<tr>
<td>Estonia</td>
<td>N/A</td>
<td>FUJITSU</td>
<td>+372 6519900 (General)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>+372 6519972 (workshop)</td>
</tr>
<tr>
<td>Georgia</td>
<td>N/A</td>
<td>Esabi</td>
<td>+995 322 91 34 71</td>
</tr>
<tr>
<td>Hungary</td>
<td>N/A</td>
<td>Profi Service</td>
<td>+36 1 814 8080 (General)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>+36 1 814 8565 (For AOC&amp;Philips only)</td>
</tr>
<tr>
<td>Kazakhstan</td>
<td>N/A</td>
<td>Classic Service I.I.c.</td>
<td>+7 727 3097515</td>
</tr>
<tr>
<td>Latvia</td>
<td>N/A</td>
<td>ServiceNet LV</td>
<td>+371 67460399</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>+371 27260399</td>
</tr>
<tr>
<td>Lithuania</td>
<td>N/A</td>
<td>UAB Servicenet</td>
<td>+370 37 400160 (general)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>+370 7400088 (for Philips)</td>
</tr>
<tr>
<td>Macedonia</td>
<td>N/A</td>
<td>AMC</td>
<td>+389 2 3125097</td>
</tr>
<tr>
<td>Moldova</td>
<td>N/A</td>
<td>Comel</td>
<td>+37322224035</td>
</tr>
<tr>
<td>Romania</td>
<td>N/A</td>
<td>Skin</td>
<td>+40 21 2101969</td>
</tr>
<tr>
<td>Russia</td>
<td>N/A</td>
<td>CPS</td>
<td>+7 (495) 645 6746</td>
</tr>
<tr>
<td>Serbia&amp;Montenegro</td>
<td>N/A</td>
<td>Kim Tec d.o.o.</td>
<td>+381 11 20 70 684</td>
</tr>
<tr>
<td>Slovakia</td>
<td>N/A</td>
<td>Datalan Service</td>
<td>+421 2 49207155</td>
</tr>
<tr>
<td>Slovenia</td>
<td>N/A</td>
<td>PC H.and</td>
<td>+386 1 530 08 24</td>
</tr>
<tr>
<td>the republic of Belarus</td>
<td>N/A</td>
<td>ServiceBy</td>
<td>+375 17 284 0203</td>
</tr>
<tr>
<td>Turkey</td>
<td>N/A</td>
<td>Tecpro</td>
<td>+90 212 444 4 832</td>
</tr>
<tr>
<td>Ukraine</td>
<td>N/A</td>
<td>Topaz</td>
<td>+38044 525 64 95</td>
</tr>
<tr>
<td></td>
<td>N/A</td>
<td>Comel</td>
<td>+380 5627444225</td>
</tr>
</tbody>
</table>

### Contact Information for LATIN AMERICA region:

<table>
<thead>
<tr>
<th>Country</th>
<th>Call center</th>
<th>Consumer care number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brazil</td>
<td>Vermont</td>
<td>0800-7254101</td>
</tr>
<tr>
<td>Argentina</td>
<td></td>
<td>0800 3330 856</td>
</tr>
</tbody>
</table>
7. Customer care and warranty

Contact Information for China:

<table>
<thead>
<tr>
<th>Country</th>
<th>Call center</th>
<th>Consumer care number</th>
</tr>
</thead>
<tbody>
<tr>
<td>China</td>
<td>PCCW Limited</td>
<td>4008 800 008</td>
</tr>
</tbody>
</table>

Contact Information for NORTH AMERICA:

<table>
<thead>
<tr>
<th>Country</th>
<th>Call center</th>
<th>Consumer care number</th>
</tr>
</thead>
<tbody>
<tr>
<td>U.S.A.</td>
<td>EPI - e-center</td>
<td>(877) 835-1838</td>
</tr>
<tr>
<td>Canada</td>
<td>EPI - e-center</td>
<td>(800)479-6696</td>
</tr>
</tbody>
</table>

Contact Information for APMEA region:

<table>
<thead>
<tr>
<th>Country</th>
<th>ASP</th>
<th>Consumer care number</th>
<th>Opening hours</th>
</tr>
</thead>
<tbody>
<tr>
<td>Australia</td>
<td>AGOS NETWORK PTY LTD</td>
<td>1300 360 386</td>
<td>Mon.~Fri. 9:00am-5:30pm</td>
</tr>
<tr>
<td>New Zealand</td>
<td>Visual Group Ltd.</td>
<td>0800 657447</td>
<td>Mon.~Fri. 8:30am-5:30pm</td>
</tr>
<tr>
<td>Hong Kong</td>
<td>Company: Smart Pixels Technology Ltd.</td>
<td>Hong Kong: Tel: +852 2619 9639</td>
<td>Mon.~Fri. 9:00am-6:00pm Sat. 9:00am-1:00pm</td>
</tr>
<tr>
<td>Macau</td>
<td></td>
<td>Macau: Tel: (853)-0800-987</td>
<td></td>
</tr>
<tr>
<td>India</td>
<td>REDINGTON INDIA LTD</td>
<td>Tel: 1 800 425 6396</td>
<td>Mon.~Fri. 9:00am-5:30pm</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SMS: PHILIPS to 56677</td>
<td></td>
</tr>
<tr>
<td>Indonesia</td>
<td>PT. CORMIC SERVISINDO PERKASA</td>
<td>+62-21-4080-9086</td>
<td>Mon.~Thu. 08:30-12:00; 13:00-17:30 Fri. 08:30-11:30; 13:00-17:30&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>+62-8888-01-9086</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>(Customer Hotline)</td>
<td></td>
</tr>
<tr>
<td>Korea</td>
<td>Alphascan Displays, Inc</td>
<td>1661-5003</td>
<td>Mon.~Fri. 9:00am-5:30pm Sat. 9:00am-1:00pm</td>
</tr>
<tr>
<td>Malaysia</td>
<td>R-Logic Sdn Bhd</td>
<td>+603 5102 3336</td>
<td>Mon.~Fri. 8:15am-5:00pm Sat. 8:30am-12:30am</td>
</tr>
<tr>
<td>Pakistan</td>
<td>TVONICS Pakistan</td>
<td>+92-213-6030100</td>
<td>Sun.~Thu. 10:00am-6:00pm</td>
</tr>
<tr>
<td>Singapore</td>
<td>Philips Singapore Pte Ltd (Philips Consumer Care Center)</td>
<td>(65) 6882 3966</td>
<td>Mon.~Fri. 9:00am-6:00pm Sat. 9:00am-1:00pm</td>
</tr>
<tr>
<td>Taiwan</td>
<td>FETEC.CO</td>
<td>0800-231-099</td>
<td>Mon.~Fri. 09:00 - 18:00</td>
</tr>
<tr>
<td>Thailand</td>
<td>Axis Computer System Co., Ltd.</td>
<td>(662) 934-5498</td>
<td>Mon.<del>Fri. 08:30am</del>05:30pm</td>
</tr>
<tr>
<td>South Africa</td>
<td>Computer Repair Technologies</td>
<td>011 262 3586</td>
<td>Mon. ~ Fri. 08:00am~05:00pm</td>
</tr>
<tr>
<td>Israel</td>
<td>Eastronics LTD</td>
<td>1-800-567000</td>
<td>Sun.~Thu. 08:00-18:00</td>
</tr>
<tr>
<td>Country</td>
<td>Company/Service Centre</td>
<td>Contact Information</td>
<td>Hours of Operation</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------------------------------------------------------------</td>
<td>-------------------------------------------</td>
<td>---------------------------------------------------------</td>
</tr>
<tr>
<td>Vietnam</td>
<td>FPT Service Informatic Company Ltd. - Ho Chi Minh City Branch</td>
<td>+84 8 38248007 Ho Chi Minh City&lt;br&gt;+84 5113.562666 Danang City&lt;br&gt;+84 5113.562666 Can tho Province</td>
<td>Mon.~Fri. 8:00-12:00, 13:30-17:30 Sat. 8:00-12:00</td>
</tr>
<tr>
<td>Philippines</td>
<td>EA Global Supply Chain Solutions, Inc.</td>
<td>(02) 655-7777, 6359456</td>
<td>Mon.<del>Fri. 8:30am</del>5:30pm</td>
</tr>
<tr>
<td>Armenia, Azerbaijan, Georgia, Kyrgyzstan, Tajikistan</td>
<td>Firebird service centre</td>
<td>+97 14 8837911</td>
<td>Sun.~Thu. 09:00 - 18:00</td>
</tr>
<tr>
<td>Uzbekistan</td>
<td>Soniko Plus Private Enterprise Ltd</td>
<td>+99871 2784650</td>
<td>Mon.~Fri. 09:00 - 18:00</td>
</tr>
<tr>
<td>Turkmenistan</td>
<td>Technostar Service Centre</td>
<td>+(99312) 460733, 460957</td>
<td>Mon.~Fri. 09:00 - 18:00</td>
</tr>
<tr>
<td>Japan</td>
<td>フィリップスモニター・サポートセンター</td>
<td>0120-060-530</td>
<td>Mon.~Fri. 10:00 - 17:00</td>
</tr>
</tbody>
</table>
8. Troubleshooting & FAQs

8.1 Troubleshooting

This page deals with problems that can be corrected by a user. If the problem still persists after you have tried these solutions, contact Philips customer service representative.

1. Common Problems

No Picture (Power LED not lit)
- Make sure the power cord is plugged into the power outlet and into the back of the monitor.
- First, ensure that the power button on the front of the monitor is in the OFF position, then press it to the ON position.

No Picture (Power LED is White)
- Make sure the computer is turned on.
- Make sure the signal cable is properly connected to your computer.
- Make sure the monitor cable has no bent pins on the connect side. If yes, repair or replace the cable.
- The Energy Saving feature may be activated

Screen says

```
Attention
Check cable connection
```

- Make sure the monitor cable is properly connected to your computer. (Also refer to the Quick Start Guide).
- Check to see if the monitor cable has bent pins.
- Make sure the computer is turned on.

AUTO button doesn’t function
- The auto function is applicable only in VGA-Analog mode. If the result is not satisfactory, you can do manual adjustments via the OSD menu.

≡ Note
The Auto Function is not applicable in DVI-Digital mode as it is not necessary.

Visible signs of smoke or sparks
- Do not perform any troubleshooting steps
- Disconnect the monitor from mains power source immediately for safety
- Contact with Philips customer service representative immediately.

2. Imaging Problems

Image is not centered
- Adjust the image position using the “Auto” function in OSD Main Controls.
- Adjust the image position using the Phase/Clock of Setup in OSD Main Controls. It is valid only in VGA mode.

Image vibrates on the screen
- Check that the signal cable is properly securely connected to the graphics board or PC.

Vertical flicker appears

- Adjust the image using the “Auto” function in OSD Main Controls.
- Eliminate the vertical bars using the Phase/Clock of Setup in OSD Main Controls. It is valid only in VGA mode.

Horizontal flicker appears

- Adjust the image using the “Auto” function in OSD Main Controls.
- Eliminate the vertical bars using the Phase/Clock of Setup in OSD Main Controls. It is valid only in VGA mode.
8. Troubleshooting & FAQs

Image appears blurred, indistinct or too dark
• Adjust the contrast and brightness on On-Screen Display.

An "after-image", "burn-in" or "ghost image" remains after the power has been turned off.
• Uninterrupted display of still or static images over an extended period may cause "burn in", also known as "after-imaging " or "ghost imaging", on your screen. "Burn- in", "after-imaging", or "ghost imaging" is a well-known phenomenon in LCD panel technology. In most cases, the "burned in" or "after-imaging" or "ghost imaging" will disappear gradually over a period of time after the power has been switched off.
• Always activate a moving screen saver program when you leave your monitor unattended.
• Always activate a periodic screen refresh application if your LCD monitor will display unchanging static content.
• Failure to activate a screen saver, or a periodic screen refresh application may result in severe “burn-in” or “after-image” or “ghost image” symptoms that will not disappear and cannot be repaired. The damage mentioned above is not covered under your warranty.

Image appears distorted. Text is fuzzy or blurred.
• Set the PC’s display resolution to the same mode as monitor’s recommended screen native resolution.

Green, red, blue, dark, and white dots appears on the screen
• The remaining dots are normal characteristic of the liquid crystal used in today’s technology. Please refer the pixel policy for more detail.

The "power on" light is too strong and is disturbing
• You can adjust “power on” light using the power LED Setup in OSD main Controls.

For further assistance, refer to the Consumer Information Centers list and contact Philips customer service representative.

8.2 SmartControl FAQs

Q1. I change the monitor on a PC to a different one and the SmartControl becomes un-usable, what do I do?
Ans.: Restart your PC and see if SmartControl can work. Otherwise, you will need to remove and re-install SmartControl to ensure proper driver is installed.

Q2. The SmartControl functions worked well before, but it does not work anymore, what can I do?
Ans.: If the following actions were executed, the monitor driver may need to be re-installed.
• Changed video graphic adapter to another one
• Updated video driver
• Activities on OS, such as service pack or patch
• Run Windows Update and updated monitor and/or video driver
• Windows was booted with the monitor power off or disconnected.
• To find out, please right click My Computer and click on Properties->Hardware->Device Manager.
• If you see “Plug and Play Monitor” shows under Monitor, then you need to re-install. Simply remove SmartControl and re-install it.

Q3. After installing SmartControl , when clicking on SmartControl tab, nothing shows up after a while or a failure message shows, what happened?
Ans.: It might be your graphic adaptor is not compatible with the SmartControl. If your graphic adaptor is one of the above mentioned brands, try to download the most updated graphic adaptor driver from
corresponding companies' web site. Install the driver. Remove SmartControl, and re-install it once more.
If it is still not working, we are sorry that the graphic adaptor is not supported. Please visit Philips website and check if an updated SmartControl driver is available.

Q4. When I click on Product Information, only partial information is shown, what happened?
Ans.: It might be your graphic card adaptor driver is not the most updated version which fully supporting DDC/CI interface. Please try to download the most updated graphic adaptor driver from corresponding companies' web site. Install the driver. Remove SmartControl and re-install it once more.

Attention

Theft Deterrence is Enabled

Q5. I forgot my PIN for Theft Deterrence Function. What can I do?
Ans.: Philips Service center has a right to ask for legitimate identification and authorization, in order to establish ownership of the monitor.
Please note that the anti-theft deterrence function is provided as a convenient free option. Managing PIN numbers is the sole responsibility of the individual user or the organization who sets it. In case the PIN number is forgotten, Philips service center can re-set it for you at a nominal charge after verification of ownership. Please note that this activity is not covered by standard warranty terms.

8.3 General FAQs

Q1: When I install my monitor what should I do if the screen shows 'Cannot display this video mode'?
Ans.: Recommended resolution for this monitor: 1920x1080@ 60Hz.
• Unplug all cables, then connect your PC to the monitor that you used previously.
• In the Windows Start Menu, select Settings/ Control Panel. In the Control Panel Window, select the Display icon. Inside the Display Control Panel, select the 'Settings' tab. Under the setting tab, in box labelled 'desktop area', move the sidebar to 1920x1080 pixels.
• Open 'Advanced Properties' and set the Refresh Rate to 60Hz, then click OK.
• Restart your computer and repeat step 2 and 3 to verify that your PC is set at 1920x1080@ 60Hz.
• Shut down your computer, disconnect your old monitor and reconnect your Philips LCD monitor.
• Turn on your monitor and then turn on your PC.

Q2: What is the recommended refresh rate for LCD monitor?
Ans.: Recommended refresh rate in LCD monitors is 60Hz. In case of any disturbance on screen, you can set it up to 75Hz to see if that removes the disturbance.

Q3: What are the .inf and .icm files on the CD-ROM? How do I install the drivers (.inf and .icm)?
Ans.: These are the driver files for your monitor. Follow the instructions in your user manual to install the drivers. Your computer may ask you for monitor drivers (.inf and .icm files) or a driver disk when you first install your monitor. Follow the instructions to insert the (companion CD-ROM) included in this package.
Monitor drivers (.inf and .icm files) will be installed automatically.

Q4: How do I adjust the resolution?
Ans.: Your video card/graphic driver and monitor together determine the available resolutions. You can select the desired resolution under Windows® Control Panel with the "Display properties".

Q5: What if I get lost when I am making monitor adjustments via OSD?
Ans.: Simply press the OK button, then select 'Reset' to recall all of the original factory settings.

Q6: Is the LCD screen resistant to scratches?
Ans.: In general, it is recommended that the panel surface is not subjected to excessive shocks and is protected from sharp or blunt objects. When handling the monitor, make sure that there is no pressure or force applied to the panel surface side. This may affect your warranty conditions.

Q7: How should I clean the LCD surface?
Ans.: For normal cleaning, use a clean, soft cloth. For extensive cleaning, please use isopropyl alcohol. Do not use other solvents such as ethyl alcohol, ethanol, acetone, hexane, etc.

Q8: Can I change the color setting of my monitor?
Ans.: Yes, you can change your color setting through OSD control as the following procedures,
• Press "OK" to show the OSD (On Screen Display) menu
• Press "Down Arrow" to select the option "Color" then press "OK" to enter color setting, there are three settings as below.
1. Color Temperature: With settings in the 6500K range the panel appears "warm, with a red-white color tone", while a 9300K temperature yields "cool, blue-white toning".
2. sRGB; this is a standard setting for ensuring correct exchange of colors between different devices (e.g. digital cameras, monitors, printers, scanners, etc)
3. User Define; the user can choose his/her preference color setting by adjusting red, green blue color.

Note
A measurement of the color of light radiated by an object while it is being heated. This measurement is expressed in terms of absolute scale, (degrees Kelvin). Lower Kelvin temperatures such as 2004K are red; higher temperatures such as 9300K are blue. Neutral temperature is white, at 6504K.

Q9: Can I connect my LCD monitor to any PC, workstation or Mac?
Ans.: Yes. All Philips LCD monitors are fully compatible with standard PCs, Macs and workstations. You may need a cable adapter to connect the monitor to your Mac system. Please contact your Philips sales representative for more information.

Q10: Are Philips LCD monitors Plug-and-Play?
Ans.: Yes, the monitors are Plug-and-Play compatible with Windows 7/Windows 8/NT, Mac OSX, Linux

Q11: What is Image Sticking, or Image Burn-in, or After Image, or Ghost Image in LCD panels?
Ans.: Uninterrupted display of still or static images over an extended period may cause "burn in", also known as "after-imaging" or "ghost imaging", on your screen. "Burn-in", "after-imaging", or "ghost imaging" is a well-known phenomenon in LCD panel technology. In most cases, the "burned in" or "after-imaging" or "ghost imaging" will disappear gradually over a period of time after the power has been switched off. Always activate a moving screen saver.
program when you leave your monitor unattended.
Always activate a periodic screen refresh application if your LCD monitor will display unchanging static content.

**Warning**
Severe "burn-in" or "after-image" or "ghost image" symptoms will not disappear and cannot be repaired. The damage mentioned above is not covered under your warranty.

Q12: Why is my display not showing sharp text, and is displaying jagged characters?
**Ans.**:
Your LCD monitor works best at its native resolution of 1920x1080@60Hz. For best display, please use this resolution.

8.4 MHL FAQs

Q1: I cannot see my mobile device image on the monitor screen
**Ans.:**

- Please check if your mobile device is MHL certified.
- You also need to have a MHL certified cable to connect the devices.
- Make sure that you have connected to the MHL-HDMI port, and that correct input is selected on the Monitor via the input selector (front bezel or OSD).
- The product is officially MHL-certified. As this monitor is a passive display, if you encounter any unexpected troubles when using the MHL input, please refer to the mobile device's user manual or contact the manufacturer of the mobile device.
- Make sure your mobile device has not entered standby (sleep) mode. If it has, then you will see a notification message on the display. Once the mobile device wakes up, the monitor's display will wake and show the images. You may need to make sure that the correct input is selected if in between you have used or connected any other device.

Q2: Why is the image on the monitor display of poor quality? My mobile device looks far better.
**Ans.:**

- The MHL standard defines fixed 1080p@30hz for output, and input. This monitor complies with this standard.
- The image quality depends on the quality of the original contents. If the content is of high resolution (example HD or 1080p), then it will appear in HD or 1080p on this monitor display. If the original content is in low resolution (example QVGA) it may look good on the mobile device due to its small screen size, but will look to be of lower quality on the large screen monitor display.

Q3: I cannot hear sound from the monitor display.
**Ans.:**

- Make sure your monitor display has built-in speakers and the volume is turned on the monitor side, and also on the mobile device side. You may also want to use optional headphones.
- If your monitor display does not have in built speakers, then you can connect optional headphones to the output on the monitor. Please ensure that the volume is turned on the monitor side, and also on the mobile device side.

For further information or FAQ, please visit official website of MHL org:

http://www.mhlconsortium.org
8.5 Gaming FAQs

1. Can I see 3D images?
   A: No, this is not 3D monitor.

2. Can I upgrade this monitor to 3D monitor?
   A: No, this cannot be upgraded to 3D technology.

3. Do I need special video card to achieve 144 Hz refresh rate?
   A: Yes, your graphics card need to have dual link DVI capability with 144Hz refresh rates and updated with the latest driver. Please refer to your card vendor directly.

4. I cannot see 144 Hz refresh rate with my DVI cable/ VGA card.
   A: Please ensure that you use Dual-link DVI card and relevant cable. Standard DVI card is not able to display 144 Hz images

5. What are the marks on the SmartKeypad for?
   A: They are preset buttons, Gamer1 and Gamer2 mode. It enables you to customize and save your favorite settings for gaming.

6. How to customize Gamer1 and Gamer2 mode?
   A: Please refer to page 11 “Customize SmartImage GAME Gamer1/ Gamer2 mode”

7. I cannot connect my external USB device with the SmartKeypad mini USB port.
   A: The SmartKeypad port on rear is designed for SmartKeypad only. Other devices cannot be connected to it.

8. Can I connect my SmartKeypad with any other display or equipment?
   A: No, the SmartKeypad is a dedicated device for this Philips display only.